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Cisco TCP/IP Suite Dialer Application
Dialer lets you start and stop a PPP or SLIP connection to a remote host. Use this application 
to:
· Manually dial, connect with, and monitor a serial connection to a remote host and begin 

a connection upon request
· Store information in profiles for frequently accessed hosts
· Create, delete, and maintain a list of remote hosts capable of connections with 

information necessary to dial, log into, and establish a connection with each host
You can start Dialer from the Cisco Suite 100 program group or from the command line.
The main Dialer window includes a connection table to show your serial connections.    The 
table includes these columns:
T

The transmit light.    Blinking indicates that you are sending packets over the serial 
interface.

R
The receive light.    Blinking indicates that you are receiving packets over the serial 
interface.

Profile
The profile used to make the connection.    "Manual" indicates a manual connection.

Status
The state of the connection:
Active

There is communications traffic on the connection.
Answer

A remote response was detected from the modem.
Connecting

A connection to the remote host is in progress.
Dialing

The modem is dialing the host.
Error

An error occurred in the modem, communications port, or kernel interface.
Idle

An active connection currently has no traffic.
Linked

A serial line session has been established with a remote host.
Negotiating

The kernel is negotiating the connection characteristics.
Offhook

The modem could not connect to the telephone line.
Shutdown

The communications and connections are shutting down.
Startup

The communications and connection parameters are initializing.



Unknown
The current status cannot be determined.

Waiting
The modem was sent information but has not yet responded.

Modem
The name of the modem, as selected in the profile.    For manual connections, this is 
shown as the communications port you are using (for example, COM1).



Command Line Dialer
You can start Dialer from an MS-DOS prompt command line with this syntax:
mndialer -h profile
You also enter the -h option as /h.



Connect Button
The Connect button, or Connect from the Interface 
menu, lets you view, modify, or delete the host 
information used to establish a PPP or SLIP 
connection with a remote host, using the Connect 
dialog box.

Disconnect Button
The Disconnect button, or Disconnect from the 
Interface menu, stops the current connection. If 
you enable the Prompt on Disconnect option in the 
Options tab of the Profile dialog box, Dialer asks 
you to confirm that you want to stop the current 
connection.

Manual Connect Button
The Manual Connect button, or Manual 
Connect>Connect from the Interface menu, lets 
you enter the commands that are sent to the 
modem to start a connection, using the Manual 
Connection dialog box.

Quick Connect
The Quick Connect button displays the profiles that
have been saved in the Profiles list in the Connect 
dialog box.    To connect to a host, double-click the 
desired profile.    A Dialer session immediately 
starts using the options specified in the New Profile
Tab Dialogs.

Exit Button
The Exit button, or Exit from the File menu, ends 
your Dialer session.

Connect Dialog Box
The Connect dialog box lets you add new profiles; view, modify, copy, and delete existing 
profiles; and connect to a host specified in a profile.    The dialog contains these fields and 
buttons:
Profiles

Displays the names of previously created profiles.    Create a profile to store information 
about a host you access frequently. 

Notes
Lists optional descriptive information for a selected profile.

Connect button



Starts a connection using the selected profile.    To exit the Connect dialog box without 
starting a connection, click the Cancel button.    The Connect button opens the Connect 
prompt dialog box, which lets you cancel the connection or display the message log 
while you are waiting for the connection to occur.

Close button
Exits the dialog without starting a connection.

New... button
Creates a new profile, using the New Profile dialog box.

Modify... button
Changes previously set profile information, using the New or Modify Profile tab dialog 
box.

Copy... button
Copies the selected profile and assigns it a new name, using the Copy Profile dialog box.  
Use this feature to create profiles that share common information.

Delete button
Deletes the selected profile.    If you have enabled the Prompt on Delete option, Dialer 
asks you to confirm the deletion.



Connect Prompt Dialog Box
The Connect Prompt dialog box lets you cancel the started connection or open the Message 
Log dialog box to display the connection protocol exchange with the remote host while you 
are waiting for the connection to occur.



Message Log Dialog Box
Use the message log to view the exchange between Dialer, the modem, and the remote 
host.    If you want to save the exchange, check Log to File and choose a name for the log 
file, which is saved to disk.    Each time you make a connection, this log is overwritten.    The 
dialog contains these elements:
Message Log window

Displays the protocol exchange with the remote host during the connection.
Log to File

Determines whether the message log is written to a file on disk.    You are prompted to 
choose a log file.    This file is overwritten each time you make a serial connection.



Save As Dialog Box
The Save As dialog box lets you save output to a file:
File Name

The name of the file in which to save the output.
Save File As Type

The file format for the file.
Directories

The directory for the file.
Drives

The drive for storing the file.
Network

Connects to another network location so you can assign it a new drive letter.



New Profile Dialog Box
The New Profile dialog box lets you specify a name for a new profile.    When you click the OK
button, the New Profile Tab Dialogs screen appears, which lets you specify profile details.
Profile names appear on the Quick Connect list and in the Profiles list in the Connect dialog 
box.



Remote Host Tab
The Remote Host tab lets you specify detailed information about the host to which you are 
connecting, your workstation, your modem, and other options.    The tab contains these 
fields:
Connection

The connection type: PPP (Point-to-Point Protocol) or SLIP (Serial Line Internet Protocol).
Phone Number

The phone number of the remote host.    Enter any long distance codes or PBX dial-out 
numbers, such as "9".    Specify a comma to cause Dialer to pause briefly while your 
phone system selects an outside line; for example, 9,555-1212.    For Direct 
Connections, do not include a telephone number.

User Name
The user name you use when you dial into a remote host. 

Prompt for Password(s)
Determines whether Dialer prompts for your password instead of storing it in the 
Password edit boxes.    Check this check box if you want Dialer to prompt you for your 
password when logging into the remote host.    Letting Dialer prompt you for passwords 
prevents unauthorized people from using your PC to access your files on the remote 
system.    Clear this check box so that the values in the Password fields are sent to the 
remote host at login.    If you are the only one with access to your PC or you are not 
concerned about the security of your files on the remote host, clear this check box.

Password 1 and Password 2
One or two passwords for logging into the remote host.    An asterisk appears for each 
character you enter for the password.    If the remote host has a router, you can enter the
router password in Password 1 and your login password in Password 2. 

User Data 1 and User Data 2
Information that is sent to the remote host in addition to your name and password.    Your
network administrator can tell you if the remote host accepts user data and the 
conventions for specifying this information.

PPP Authentication
Lets you specify what type of PPP authentication occurs when you log into the remote 
host, depending on whether you specify an authentication password and user name.    
If you know that the remote host is authenticating using PAP, do not specify your user 
name, but do specify an authentication password.    This password is not the same as 
your password on the remote host.
If you know that the remote host is authenticating using CHAP, specify both a user name 
and password.
If the remote host does not provide authentication, leave these fields blank.



PPP Authentication
Dialer negotiates PPP authentication with the remote host automatically to request PAP, 
CHAP, or no authentication depending on what the remote host provides.    However, you can
make logging in faster if you know what type of authentication is occurring on the remote 
host. Contact your network administrator for more information. If you want to specify that 
Dialer first request PAP authentication, enter only your password, but do not specify your 
user name.    If you want Dialer to first request CHAP, enter both a user name and password.  
If you want Dialer to first request no authentication, leave both edit boxes blank.



PAP Authentication
PAP (Password Authentication Protocol) uses the authentication password to determine if you
can log into the remote host. However, this password is less secure on the network. CHAP 
provides additional security to protect the authentication password.



CHAP Authentication
CHAP (Challenge-Handshake Authentication Protocol) tests both your user name and the 
authentication password, and provides additional network security.



Local Host Tab
The Local Host tab lets you specify information about your workstation.    The tab contains 
these fields:
IP Address

The IP address of your workstation; for example, 192.168.34.22.    If you are using PPP 
and do not have an IP address, leave this field blank.    If you are using SLIP, your network
administrator can supply the IP address for your workstation.    If you create a login script
on the Script tab and specify that you expect an IP address from the remote host, the 
value is inserted into this field.

Use as Default Route
Indicates that Dialer should use the IP address and subnet mask entered in the IP 
Address and Subnet Mask fields for the default route for Dialer.

Subnet Mask
The subnet mask,; for example, 255.255.255.0.    Your network administrator can 
provide the subnet mask for your system.

PC Host Name
The host name of your workstation; for example HOLMES.

Domain Name
The domain name of your workstation; for example YOYODYNE.COM.    Domains provide a 
hierarchial grouping of hosts within the Internet.    Domain names are assigned by the 
Internet naming authority and can pertain to your site, organization, or the type of 
organization in which you participate.    Your network administrator can supply the 
domain name.

Routing
Routing is the process of selecting the path that data must take to reach its destination.
Destination Column

The IP addresses of destination systems.
Gateway Column

The IP addresses of gateway systems.
Qualifier Column

The route qualifier types, which are Host for a host address qualifier and Network for 
a network address qualifier.

Add button
Adds new gateway and destination IP addresses for an additional route.

Delete button
Deletes the selected route entry.

DNS Server IP Address
Displays the IP addresses of servers providing DNS (Domain Name Service) lookup 
services.
Add button

Adds the IP address of servers providing DNS lookup services.
Delete button

Deletes a DNS server entry.





Add Route Dialog Box
The Add Route dialog box lets you add a route in addition to the default route.    This dialog 
box contains the same features as those available when adding a route from the Routing tab
in the Configuration Utility.    The dialog contains these fields:
Destination Address

The IP address for the host or network you wish to reach.
Gateway Address

The IP address of the gateway you want to use to reach your destination.
Address Qualifier

Determines whether the destination is another host or a network.



Add DNS Dialog Box
The Add DNS dialog box lets you add a DNS (Domain Name Service) server from which to 
request DNS lookup services.    Enter the IP address of the DNS server and click OK.



Modem Tab
The Modem tab lets you specify modem settings and commands.    The tab contains these 
fields:
Settings

Information about your modem and its features.
Manufacturer

The manufacturer of your modem.    Use Direct Connection if you are connecting 
directly to a host through your serial port.

Model
The model of your modem.    For Direct Connection, choose Serial.

Speed
The baud rate of your modem.    Baud rates are measured in bits per second (bps).    
The Ports control panel can provide information on the modem speed.    For Direct 
Connections, this must be the same as the speed used by the remote host: unlike 
modem connections, direct connections cannot negotiate the speed.

Port
The port to which your modem is connected to your workstation.

Retries
The number of times Dialer should attempt to connect to the remote host before 
reporting a failure.

Timeout
The duration in seconds that Dialer should wait for a response from the remote host 
before causing the connection attempt to fail.

Follow DCD
Determines whether your modem supports the DCD (Data Carrier Detect) pin on the 
RS-232 interface.    Refer to your modem documentation or contact your network 
administrator to determine if your modem supports this feature.

Hardware Flow
Determines whether your modem supports the ability to enable or disable the Clear 
To Send (CTS) and the Ready To Send (RTS) pins of the RS-232 interface, known as 
RTS/CTS flow control.    Refer to your modem documentation or contact your network 
administrator to determine if your modem supports this feature.

7 Bits Until Connected
Sends data as 7-bit characters until the connection occurs and then switches to 8-bit 
characters.    Some online service providers require the use of this feature.

Commands
Commands sent to the modem to start the connection or to the remote host to log in. 
Refer to your modem documentation for more information.
Init

A string of characters to initialize your modem.
Reset

A string of characters to reset your modem.
Dial

A string of characters to initiate a dialing sequence to the remote host.



Postdial
One or more characters to immediately follow the Dial string.

Hangup
A string of character used to hang up (drop carrier on) the phone line.

Ack
A string of characters that Dialer should receive from your modem to signal a 
command acknowledge.

Connect
A string of characters that Dialer should receive from your modem to signal a carrier 
detect response.

Busy
A string of characters that Dialer should receive from your modem to signal that the 
line is busy.

Defaults button
Lets you revert the modem parameters back to their default settings for the current 
modem type.



Script Tab
The Script tab lets you specify commands that are sent and received from the remote host 
when you log in.    Use login scripts to automate login authentication.    A Dialer script is a 
series of commands and expected reples that you specify using the Send and Expect combo 
boxes.    Each command and reply sequence also includes a timeout value, which is the 
number of seconds Dialer waits for the expected reply from the remote host before quitting 
the login attempt.    As you enter each command-and-reply and click the Add button, they 
appear in the Script table on the tab.    Modify a command and reply sequence by clicking 
the Modify... button, which opens the Modify Script Entry dialog box which lets you select a 
new command and reply.    You can delete a sequence by clicking the Delete button.
The tab contains these fields:
Auto Dial

Determines whether Dialer initializes the modem and dials the phone number specified 
on the Remote Host tab before executing the script.    Use of this check    box determines 
how the Send and Expect edit box values interact with the remote host.    If you check 
this check box (enable Auto Dial), then the order is as shown on the tab: you send a 
variable and expect to receive a value such as the IP address from the remote host. 
If you clear this check box (disable Auto Dial), the Send and Expect edit boxes appear to 
be in reversed logic.    Now the remote host sends text from which you expect to receive 
a value, and then upon receiving the value, you send your information.    For example, 
when you clear the Auto Dial check box, you start a dial-in, the remote host sends a 
welcome string, you expect a user name prompt, and when received, you send your user
name.    Then you expect a password prompt, to which you send your password.
Uncheck Auto Dial for Direct Connections.

Script
Commands sent to the remote host and replies expected from that host.
Send Column

Lists information that Dialer sends to the remote host.
Expect Column

Lists information that you expect the Remote host to send to Dialer.
Timeout Column

The number of seconds Dialer waits for each expected reply from the remote host 
before quitting the login attempt..

Modify... button
Edits the selected login script statement.    Use the Send and Expect fields at the 
bottom of the tab to add a login script statement.

Delete button
Deletes the selected login script statement.

Send
Variables or a string of text to be sent to the remote host.    The preset variables are:
$IPADDRESS

Send the IP Address value specified in the IP Address edit box in the Local Host tab.
$PASSWORD1

Send the Password 1 value specified in the Password 1 edit box in the Remote Host 
tab.



$PASSWORD2
Send the Password 2 value specified in the Password 2 edit box in the Remote Host 
tab.

$PHONE
Send the phone number stored in the Phone Number edit box in the Remote Host tab.

$USERDATA1
Send the User Data 1 value specified in the User Data 1 edit box in the Remote Host 
tab.

$USERDATA2
Send the User Data 2 value specified in the User Data 2 edit box in the Remote Host 
tab.

$USERNAME
Send the user name stored in the User Name edit box in the Remote Host tab.

<NOTHING>
Indicates that you want no data sent.    You can use this as a placeholder when you 
only want to send a carriage return.

<cr>
Send a carriage return.    This is equivalent to pressing the Enter key.

Expect
A reply that you expect from the remote host.    The only preset value is $IPADDRESS, 
which you can use when you want the remote host to supply the IP address for you.    
Dialer stores it in the IP Address edit box in the Local Host tab.    You can also specify a 
string of text that you expect from the remote host, for example, "Welcome to our host."

Timout
The number of seconds Dialer waits for each expected reply from the remote host before
quitting the login attempt.

Append Carriage Return to Send String
Determines whether a carriage return is appended to the send string.    Your network 
administrator provides this information.    Check the check box if the remote host expects
each command sent to it to be terminated with a carriage return.    Clear the check box if 
the remote host does not require a carriage return to the be sent with each command.

Add button
Adds the login script statement to the Script list on the tab.



Modify Script Entry Dialog Box
The Modify Script Entry dialog box lets you change an existing command to be sent to the 
remote host, a reply expected from the remote host, and the number of seconds Dialer 
should wait for the reply before quitting the login attempt.
Send

Variables or a string of text to be sent to the remote host.    The preset variables are:
$IPADDRESS

Send the IP Address value specified in the IP Address edit box in the Local Host tab.
$PASSWORD1

Send the Password 1 value specified in the Password 1 edit box in the Remote Host 
tab.

$PASSWORD2
Send the Password 2 value specified in the Password 2 edit box in the Remote Host 
tab.

$PHONE
Send the phone number stored in the Phone Number edit box in the Remote Host tab.

$USERDATA1
Send the User Data 1 value specified in the User Data 1 edit box in the Remote Host 
tab.

$USERDATA2
Send the User Data 2 value specified in the User Data 2 edit box in the Remote Host 
tab.

$USERNAME
Send the user name stored in the User Name edit box in the Remote Host tab.

<NOTHING>
Indicates that you want no data sent.    You can use this as a placeholder when you 
only want to send a carriage return.

<cr>
Send a carriage return.    This is equivalent to pressing the Enter key.

Expect
A reply that you expect from the remote host.    The only preset value is $IPADDRESS, 
which you can use when you want the remote host to supply the IP address for you.    
Dialer stores it in the IP Address edit box in the Local Host tab.    You can also specify a 
string of text that you expect from the remote host, for example, "Welcome to our host."

Timout
The number of seconds Dialer waits for each expected reply from the remote host before
quitting the login attempt.

Append Carriage Return to Send String
Determines whether a carriage return is appended to the send string.    Your network 
administrator provides this information.    Check the check box if the remote host expects
each command sent to it to be terminated with a carriage return.    Clear the check box if 
the remote host does not require a carriage return to the be sent with each command.



Options Tab
The Options tab lets you specify connection and header compression options.    The tab 
contains these fields:
Connection group

Contains Dialer options.
Re-establish Connection Upon Loss

Determines whether to re-establish the connection if the line carrier drops.    If you 
check this check box, Dialer automatically attempts to reconnect to the remote host 
if the line carrier drops.

Minimize on Connect
Determines whether the Dialer activity window appears as an icon when a connection
is established.

Prompt on Disconnect
Determines whether Dialer presents a confirmation dialog box when you disconnect 
from the remote host.

Idle disconnect nn minutes
The number of minutes Dialer should wait without activity from the remote host 
before closing a connection.    Specify zero (0) to never time out.    The maximum is 
1092 minutes (18.2 hours).

Header Compression
Determines whether Dialer should use header compression for SLIP packets. This group 
of commands is only available for SLIP connections.    PPP handles header compression 
automatically.
If header compression is enabled on both hosts, communications are quicker.    To use 
compressed headers, at least one host must have header compressed enabled.    Contact
your network administrator for the remote host to ensure header compression is in 
effect.
On

Indicates that headers should always be compressed.
Off

Indicates that headers should never be compressed.
Negotiated

Indicates that headers are not compressed until a compressed header is received 
from the other side.

Notes
Information you can enter to describe the purpose of this profile.



Confirm Delete Dialog Box
The Confirm Delete dialog box lets you confirm that you want to delete a profile.



Manual Connect Configuration Settings Tab
The Manual Connect Configuration Settings tab lets you configure modem settings.    The tab
contains these fields:
Modem

Information about your modem and its features.
Speed

The baud rate of your modem.    Baud rates are measured in bits per second (bps).    
The Ports control panel can provide information on the modem speed.    For Direct 
Connections, this must be the same speed used by the host.

Port
The port to which your modem is connected to your workstation.

Follow DCD
Determines whether your modem supports the DCD (Data Carrier Detect) pin on the 
RS-232 interface.    Refer to your modem documentation or contact your network 
administrator to determine if your modem supports this feature.

Hardware Flow
Determines whether your modem supports the ability to enable or disable the Clear 
To Send (CTS) and the Ready To Send (RTS) pins of the RS-232 interface, known as 
RTS/CTS flow control.    Refer to your modem documentation or contact your network 
administrator to determine if your modem supports this feature.

7 Bits Until Connected
Sends data as 7-bit characters until the connection occurs and then switches to 8-bit 
characters.    Some online service providers require the use of this feature.

Header Compression
Determines whether Dialer should use header compression for SLIP packets. This group 
of commands is only available for SLIP connections.    PPP handles header compression 
automatically.
If header compression is enabled on both hosts, communications are quicker.    To use 
compressed headers, at least one host must have header compressed enabled.    Contact
your network administrator for the remote host to ensure header compression is in 
effect.
On

Indicates that headers should always be compressed.
Off

Indicates that headers should never be compressed.
Negotiated

Indicates that headers are not compressed until a compressed header is received 
from the other side.

Connection group
Contains Dialer options.
Minimize on Connect

Determines whether the Dialer activity window appears as an icon when a connection
is established.

Prompt on Disconnect



Determines whether Dialer presents a confirmation dialog box when you disconnect 
from the remote host.

See Also:

· Host Information tab
· PPP Manual Connect dialog box
· SLIP Manual Connect dialog box
· Manually Connecting to a Remote Host
· Configuring the Serial Interface



Manual Connect Configuration Host Information Tab
The Manual Connect Configuration Host Information tab lets you configure information about
the remote host.    The tab contains these fields:
IP Address

The IP address of your workstation; for example, 192.168.34.22.    If you are using PPP 
and do not have an IP address, leave this field blank.    If you are using SLIP, your network
administrator can supply the IP address for your workstation.    If you create a login script
on the Script tab and specify that you expect an IP address from the remote host, the 
value is inserted into this field.

Use as Default Route
Indicates that Dialer should use the IP address and subnet mask entered in the IP 
Address and Subnet Mask fields for the default route for Dialer.

Subnet Mask
The subnet mask,; for example, 255.255.255.0.    Your network administrator can 
provide the subnet mask for your system.

PC Host Name
The host name of your workstation; for example HOLMES.

Domain Name
The domain name of your workstation; for example YOYODYNE.COM.    Domains provide a 
hierarchial grouping of hosts within the Internet.    Domain names are assigned by the 
Internet naming authority and can pertain to your site, organization, or the type of 
organization in which you participate.    Your network administrator can supply the 
domain name.

Routing
Routing is the process of selecting the path that data must take to reach its destination.
Destination Column

The IP addresses of destination systems.
Gateway Column

The IP addresses of gateway systems.
Qualifier Column

The route qualifier types, which are Host for a host address qualifier and Network for 
a network address qualifier.

Add button
Adds new gateway and destination IP addresses for an additional route.

Delete button
Deletes the selected route entry.

DNS Server IP Address
Displays the IP addresses of servers providing DNS (Domain Name Service) lookup 
services.
Add button

Adds the IP address of servers providing DNS lookup services.
Delete button

Deletes a DNS server entry.
PPP Authentication



Lets you specify what type of PPP authentication occurs when you log into the remote 
host, depending on whether you specify an authentication password and user name.    
If you know that the remote host is authenticating using PAP, do not specify your user 
name, but do specify an authentication password.    This password is not the same as 
your password on the remote host.
If you know that the remote host is authenticating using CHAP, specify both a user name 
and password.
If the remote host does not provide authentication, leave these fields blank.

See Also:

· Settings tab
· PPP Manual Connect dialog box
· SLIP Manual Connect dialog box
· Manually Connecting to a Remote Host
· Configuring the Serial Interface



Copy Profile Dialog Box
The Copy Profile dialog box lets you create a new profile with the same information as an 
existing profile.    It shows the name of the profile from which you are copying information.    
Enter the name of a new profile to create.



Password(s) Dialog Box
The Password(s) dialog box lets you specify one or two passwords that are supplied during 
connection to the remote host.    An asterisk appears for each character you enter for the 
password.    If the remote host has a router, you can enter the router password in Password 1
and your login password in Password 2.



Manual Connect Dialog Box (PPP)
The Manual Connect Dialog Box lets you connect to a remote host using PPP by entering 
commands directly to the modem and the remote host.    It contains these windows, fields, 
and buttons:
Terminal View

Lets you interact directly with your serial interface and with the remote host.    All data 
received by the serial interface appears in this window.    To enter commands directly to 
the serial interface, type the command and press the Enter key.

IP Address
The IP address for the connection.    For PPP, you can either supply an IP address for the 
connection or leave the edit box blank so that the server supplies the IP address for you.

PPP button
Starts PPP communications on your workstation.    Once Dialer establishes the PPP 
connection, enter your IP address in the IP Address edit box, and click the PPP button to 
start a PPP session.

Print... button
Prints the contents of the Terminal View window , using the Print dialog box.

See Also:

· SLIP Manual Connect dialog box
· Manually Connecting to a Remote Host
· Configure Manual Interface dialog box
· Configuring the Serial Interface



Manual Connect Dialog Box (SLIP)
The Manual Connect Dialog Box lets you connect to a remote host using SLIP by entering 
commands directly to the modem and the remote host.
Terminal View

Lets you interact directly with your serial interface and with the remote host.    All data 
received by the serial interface appears in this window.    To enter commands directly to 
the serial interface, type the command and press the Enter key.

IP Address
The IP address for the connection.    For SLIP, if the server is configured to supply an IP 
address, leave this edit box blank.    When the connnection starts, the IP address appears,
which you then enter in the edit box before clicking the SLIP button to establish the 
connection.

SLIP
The SLIP button starts SLIP communications on the local host.    Once Dialer establishes 
the SLIP connection, enter your IP address in the IP Address edit box, and click the SLIP 
button to start SLIP on the local host.

Print... button
Prints the contents of the Terminal View window , using the Print dialog box.

See Also:

· PPP Manual Connect dialog box
· Manually Connecting to a Remote Host
· Configure Manual Interface dialog box
· Configuring the Serial Interface



Print Dialog Box
The Print dialog box lets you print the output from the Terminal View window in the Manual 
Connect dialog box.
Printer

Shows the active printer and printer connection.    Click the Setup button to change the 
printer and printer connection.

Print Range group
Lets you specify the pages you want to print:    All pages; just the data you selected in 
the window; or a specific page range.

Print Quality
Determines how clear the printout is, based on the capabilities of your printer.

Copies
The number of copies you want to print.

Collate Copies
Whether you want each copy printed in page number order (checked), or whether you 
want all copies of each page printed together, so that, for example, all page ones are 
printed first before printing page two (unchecked).

Setup button
Lets you select a printer and set other printer options using the Print Setup dialog box.



Print Setup Dialog Box
The Print Setup dialog box lets you select a printer, page orientation and dimensions, paper 
source and other options:
Printer group

Lets you select either the default printer, or another printer that you have installed.
Orientation group

Determines whether the printout is in portrait or landscape orientation.
Paper group

Determines the size of the paper and the paper tray that is used.
Options button

Additional options that you can set for the selected printer.
Network button

Lets you connect to a printer on your network.



File Menu
The File menu contains these commands:
Exit

Exits the Dialer application.    The shortcut button is:



Interface Menu
The Interface menu contains these commands:
Connect

Connects to the remote host and lets you view, modify, or delete the host information 
used to establish a PPP or SLIP connection, using the Connect dialog box.    The shortcut 
button is:

Manual Connect>Connect
Lets you enter the commands that are sent to the modem to start a connection, using 
the Manual Connection dialog box.    The shortcut button is:

Manual Connect>Configure
Lets you specify modem settings and host information before you start a manual 
connection, using the Configure Manual Interface dialog box (Settings tab).

Disconnect
Stops the current connection.    If you enable the Prompt on Disconnect option in the 
Options tab of the Profile dialog box, Dialer asks you to confirm that you want to stop the
current connection.    The shortcut button is:

Disconnect All
Stops all connections.    If you check the Prompt on Disconnect check box in the Options 
tab of the Profile dialog box, Dialer displays a dialog box asking you to confirm this 
request.



Options Menu
The Options menu contains these commands:
Program

Sets Dialer program options using the Program Options dialog box.
Toolbar

Displays or hides the toolbar, which is the bar of shortcut buttons beneath the menu.
Bubble Help

Enables or disables bubble help, which is the quick popup help you get when moving the 
cursor over the toolbar buttons.

Status Bar
Displays or hides the status bar at the bottom of the main window.



Program Options Dialog Box
The Program Options dialog box lets you select various program settings for Dialer.    The 
dialog contains these fields:
Dial on Demand

Lets you specify that applications accessing the network through the WinSock interface 
automatically start Dialer before starting the application.
Enabled

Lets you start Dial on Demand.    Any changes to this setting do not take effect until 
you reboot Windows.

Use Profile
Lets you start the Dialer connection from a profile.    If you do not specify a profile, 
Dialer displays the activity window so that you can start the connection manually or 
from a profile.

Alert on System Suspend
Determines whether Dialer displays a reminder message when your workstation enters 
power save mode.

Prompt on Delete
Determines whether Dialer prompts you if you delete a profile.

Save Screen Size and Location
Determines whether Dialer retains the screen size and location between Dialer sessions.



Help Menu
The Help menu contains these commands:
Contents

Displays the contents page of this help file.
Search for Help on

Searches this help files index.
How to Use Help

Displays help information for using the Windows help system.
About Dialer

Displays version information for the application.



About Dialer
The version number of Dialer.



Dialer Toolbar
The Dialer toolbar provides shortcut buttons to start and stop Dialer sessions, connect 
quickly to a host, and exit Dialer.
The toolbar is:

Click graphic fields for more information.



Quick Connect List
The Quick Connect list displays profiles you have previously defined.    Select the profile you 
want to use and you will connect to the defined host.
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Manually Connecting to a Remote Host
To manually connect to a remote host:

1. Click the Manual Connect button, or choose Manual Connect>Connect from the Interface 
menu.    The Manual Connect dialog box appears.    (If Dialer cannot communicate with 
your modem, the Configure Interface dialog box appears.    See Configuring the Serial 
Interface..)

2. In the Terminal View window, enter the modem command and the phone number you 
want to dial.    For example, on a U.S. Robotics modem, enter the modem command in 
the format ATDTphone_number, where phone_number is the phone number for the 
remote host; an example modem command is ATDT5551212.    Use a comma to cause 
Dialer to pause; for example, for waiting to receive an outside line    through an office 
PBX phone system. The modem dials the phone number and connects to the remote 
host. Depending on the remote host, when the connection is established, a message 
appears.

3. In the Terminal View window, enter the appropriate command to start either PPP or SLIP 
on the remote host.    The command depends on the remote host.    If you need 
assistance, contact your network administrator.

4. If you are starting a PPP connection, leave the IP Address blank and the remote host will 
assign an IP address for you.    If you are starting a SLIP connection, and if the remote 
host supplies an IP address for you, leave the IP Address edit box blank. When the 
remote host displays the IP address, enter the address in the IP Address edit box.    If the 
remote host does not supply an IP address, enter your IP address in the IP Address edit 
box.

5. When communications are confirmed by the remote host, click the PPP button or SLIP 
button depending on which type of connection you are making. Once communication 
starts, the Manual Connect dialog box disappears, and the active session type appears in
the Dialer activity window.    You may now run any application you want, such as Telnet or
FTP.

6. To print the output of the Terminal View window, click the Print button. To close the 
Manual Connect dialog box, click the Cancel button.



Configuring the Serial Interface
To configure the serial interface:

1. Choose Manual Connect>Configure from the Interface menu.    The Configure Manual 
Interface dialog    box appears.

2. Choose either PPP or SLIP for the connection type.
3. Choose the speed of your modem.
4. Choose the port to which your modem is connected from the Port drop-down list.
5. The connection type, modem speed, and port are the only information required for most 

manual connections. If you are using manual connect for the first time, or do not know 
whether the other options are necessary for your situation, click OK to return to the 
Dialer Application window.    Otherwise, continue with the next step.

6. If the remote host supports Follow DCD or Hardware Flow control, check each check box 
as needed.

7. If you are configuring a SLIP connection, choose whether or not to use header 
compression by clicking the appropriate Header Compression Group radio button.    PPP 
handles header compression automatically.

8. To automatically try to re-establish a connection using this profile if the connection is 
lost, check the Re-establish Connection Upon Loss check box.

9. Click the Host Information tab.
10. If you need to override the IP address, subnet mask, your workstation host name, or 

domain name address that you provided when you installed Cisco TCP/IP Suite, enter the 
new information in the appropriate edit boxes.    If you need to add a new route or the IP 
address of a DNS name server providing host lookups, click the respective Add button 
and enter the information.    Refer to Adding Additional Routes and Adding Additional 
Domain Name Servers for more information.

11. Click the OK button to return to the Dialer Application window.



Creating a Dialer Profile
To create a Dialer profile:

1. Collect the information listed in Preparing to Make a Connection.
2. From the Dialer application window, click the Connect button, or select Connect from the 

Interface menu.    The Connect dialog box appears.
3. Click the New... button in the Connect dialog box.    The New Profile dialog box appears.
4. Enter the name you want to give the new profile in the Profile Name edit box.
5. Click the OK button.    The Profile dialog box appears.
6. Set the desired options for the remote host, local host, your modem, a login script, and 

Dialer options.
7. Click the OK button.    The Profile dialog box closes, returning you to the Connect dialog 

box. The new profile appears in the Profiles list box.    Once you create a profile, you can 
start a connection from the Dialer activity window, with Dial on Demand, and from the 
command line.



Setting Remote Host Options
To set the remote host options:

1. Click the Remote Host tab on the Profile dialog box.
2. Enter the phone number of the remote host. Be sure to enter any numbers necessary to 

access an outside line.    Use a comma to indicate Dialer should pause before continuing 
to dial.

3. Enter your login name (user name) at the remote host.
4. If you want Dialer to prompt you to enter your password before connecting to the remote

host, check the Prompt For Password check box.    To save your password to this remote 
host in the Dialer profile, clear the Prompt For Password check box and enter your 
password into the Password 1 and 2 edit boxes.    If you save your passwords in the Dialer
profile, anyone using your workstation can connect to the remote host using your user 
name and password.    

5. Enter any optional data you may need to give the remote host in the User Data 1 and 2 
edit boxes. These edit boxes can store data for use in a login script.

6. Either continue setting options on other tabs, or click OK to return to the Connect dialog 
box. 



Setting Local Host Options
To set the local host options:

1. Click the Local Host tab in the Profile dialog box.
2. Enter the IP address of the local host. Leave this field blank if the IP address is assigned 

dynamically by the remote host. If you want the IP address you entered to be the default 
route, check the Use as Default Route check box. If you do not want the IP address you 
entered to be the default route, clear the Use as Default Route check box.

3. Enter the subnet mask of the local network.
4. Either continue setting options on other tabs, or click the OK button to return to the 

Connect dialog box. 



Setting Modem Options
To set the modem options:

1. Click the Modem tab in the Profiles dialog box.
2. Choose the modem's manufacturer and model.    If your modem does not appear in the 

lists, choose a generic type.    Choose Direct Connection if you are directly connecting to 
the host through your serial port.

3. Choose the speed of your modem.    For Direct Connections, this speed must be the same
as used by the host.

4. Choose the serial port to which your modem is connected.
5. Enter the number of retries you want the modem to try to establish communications 

after an unsuccessful attempt.
6. Enter the number in seconds you want to pass before the modem terminates an 

unsuccessful communication attempt.
7. The rest of the information in the Modem tab is set to the standard modem command set

by default. If your modem uses the standard command set, you do not need to change 
any of the defaults. If your modem does not use the standard command set, enter the 
proper commands for your modem. See your modem documentation for more 
information.

8. Either continue setting options on other tabs, or click OK to return to the Connect dialog 
box.



Setting Script Options
Most remote hosts require some authentication, such as a user name and password, before 
allowing a user to login. A login script is an automated process that provides this 
authentication to the remote host. 
A Dialer script is a series of commands sent to the remote host and expected replies from 
the remote host. The commands and replies can be:
· Text, which Dialer sends and expects exactly as entered
· A preset variable, which in the case of a Send command, causes Dialer to send the value 

stored in the corresponding edit box, or in the case of an expected reply, causes Dialer to
receive the value from the remote host and store the value in the corresponding edit box

· Any combination of the other two options
Each command and reply sequence also includes a timeout value, which is the number of 
seconds Dialer waits for the expected reply before aborting the login attempt.
Each step in the script can contain either a command sent, a reply expected, or both.
The most important aspect of creating a script is to understand exactly what your service 
provider will send in response to your action. For example, consider the following connection
sequence:

You: Dial the phone number
Remote Host: Answers the phone and displays Password:
You: Send your password
Remote Host: Receives your password, displays SysPrompt>, and sends 

an IP address
You: Send a command that contains the IP address to start the 

SLIP session
Now you are connected and ready to use another application. To create this example, the 
login script would appear as:

Send Expect
Password:

$PASSWORD1<cr> SysPrompt>
SLIP $IPADDRESS<cr>
Send Values

The Send value in a script can be either a text string or a preset variable. The preset 
variables are:
$IPADDRESS

Send the IP Address value specified in the IP Address edit box in the Local Host tab.
$PASSWORD1

Send the Password 1 value specified in the Password 1 edit box in the Remote Host tab.
$PASSWORD2

Send the Password 2 value specified in the Password 2 edit box in the Remote Host tab.
$PHONE

Send the phone number stored in the Phone Number edit box in the Remote Host tab.
$USERDATA1

Send the User Data 1 value specified in the User Data 1 edit box in the Remote Host tab.



$USERDATA2
Send the User Data 2 value specified in the User Data 2 edit box in the Remote Host tab.

$USERNAME
Send the user name stored in the User Name edit box in the Remote Host tab.

<NOTHING>
Indicates that you want no data sent.    You can use this as a placeholder when you only 
want to send a carriage return.

<cr>
Send a carriage return.    This is equivalent to pressing the Enter key.

Expect Values

The Expect values can either be a text string or $IPADDRESS, which stores the IP address in 
the IP Address edit box in the Local Host tab.
To create a login script:

1. Click the Script tab in the Profile dialog box.
2. If you want Dialer to automatically initialize the modem and dial the phone number 

entered in the Remote Host tab before executing the script, click the Auto Dial check 
box.    If you want to enter the commands to initialize the modem and dial the phone 
number in the script, clear the Auto Dial check box.

3. Enter the command you want to initially send the remote host in the Send box. You can 
either enter a command, which will be sent exactly as entered, or choose a preset 
variable from the drop-down list.

4. Enter the reply you expect from the remote host in the Expect box. You can enter a reply,
which will be expected exactly as entered, or you can choose a preset variable from the 
drop-down list. If you choose a variable from the drop-down list, the reply received is 
stored in that variable.

5. The value received is stored in the IP Address field in the Local Host tab.
6. Enter the number of seconds to wait for the expected reply before terminating the login 

attempt.
7. If the remote host requires a carriage return after the Send command, check the Append 

Carriage Return check box. 
8. If the remote host does not require a carriage return, clear the Append Carriage Return 

check box.
9. Click Add.
10. Repeat steps 3-7 for each command in the script.
11. Either continue setting options on other tabs, or click the OK button to return to the 

Connect dialog box. 



Setting Dialer Options
To set the Dialer options:

1. Click the Options tab in the Profiles dialog box.
2. To automatically try to re-establish a connection using this profile if the connection is 

lost, check the Re-establish Connection Upon Loss check box. To prevent Dialer from 
trying to re-establish a connection if the connection is lost, clear the Re-establish 
Connection Upon Loss check box.

3. To minimize the Dialer window once the connection using this profile is made, check the 
Minimize on Connect check box. To keep the Dialer window at its regular size once the 
connection using this profile is made, clear the Minimize on Connect check box.

4. To have Dialer prompt you for confirmation before disconnecting, check the Prompt on 
Disconnect check box. To prevent Dialer from prompting you when disconnecting, clear 
the Prompt on Disconnect check box.

5. To automatically close the connection after a certain number of seconds with no activity, 
enter the number of seconds in the Idle Disconnect edit box. To prevent Dialer from 
automatically disconnecting, enter 0 (zero).

6. Choose whether or not to use header compression by clicking the appropriate Header 
Compression radio button. If header compression is enabled on both hosts, 
communications are quicker. The On radio button indicates that headers should always 
be compressed. The Off radio button indicates that headers should never be 
compressed. The Negotiated radio button indicates that headers are not compressed 
until a compressed header is received from the other side. To use compressed headers, 
at least one host must have header compressed enabled.

7. Either continue setting options on other tabs or click OK to return to the Connect dialog 
box.



Printing the Terminal Window Output
To print the Terminal window output:

1. Click the Print... button on the Manual Connect dialog box.    The Print dialog box appears:
2. Specify the desired print options in the dialog box.
3. Click the OK button.



Saving Message Log Output In a File
To save message log output in a file:

· Check Log to File on the Message Log dialog box.    You are prompt to choose a log file 
name.    This log file is overwritten every time you make a serial connection.



Adding Additional Routes
To add additional routes:

1. In the Dialer application window, click the Connect button, or select Connect from the 
Interface menu.    The Connect dialog box appears.

2. Select the profile you want to modify by clicking on its name.
3. Click the Modify... button. The Profile dialog box appears.
4. Click the Local Host tab.
5. Click the Add... button in the Routing group.    The Add Route dialog box appears.
6. Enter the destination IP address.
7. Enter the gateway IP address.
8. If you want the local host to qualify the IP address, click the Host radio button.
9. If you want the network to qualify the IP address, click the Network radio button.
10. Click OK. The Add Route dialog box closes, returning you to the Local Host tab.
11. Click OK. The Profile dialog box closes, returning you to the Connect dialog box



Adding Additional Domain Name Servers
To add additional domain name servers:

1. In the Dialer application window, click the Connect button, or select Connect from the 
Interface menu.    The Connect dialog box appears.

2. Select the profile you want to modify by clicking on its name.
3. Click the Modify... button.    The Profile dialog box appears.
4. Click the Local Host tab.
5. Click the Add... button in the DNS group.    The Add DNS dialog box appears.
6. Enter the IP address of the DNS server into the Name Server Address edit box.
7. Click OK.
8. The Add DNS dialog box closes, returning you to the Local Host tab. The DNS server 

appears in the DNS Server IP Addresses list box.
9. Click OK.
10. The Profile dialog box closes, returning you to the Connect dialog 

boxConnect_Dialog_Box.



Setting Dial on Demand
Dial on Demand permits applications that access the network through the WinSock interface 
to automatically start Dialer before starting the application.
To set Dial on Demand:

1. Choose the Program... command from the Options menu. 
2. Click Enabled to start Dial on Demand.
3. If you want to start Dialer from a profile, click Use profile and choose the profile name 

from the list.    If you do not start Dialer from a profile, when Dialer starts, the main 
activity window appears and you can start the connection either manually or by 
specifying a profile.
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Dialer Overview
The Dialer application lets you establish a PPP (Point-to-Point Protocol) or SLIP (Serial Line IP)
connection to a remote host. 
With both PPP and SLIP, you can connect to a remote host over phone lines using a modem, 
or with a direct serial-line connection. Once a connection has been made, your PC is 
recognized as a host on the remote host's network.    PPP and SLIP are common ways to 
connect to the Internet without having a direct Ethernet connection.
Like SLIP, PPP (Point-to-Point Protocol) allows the transmission of IP packets over serial lines. 
PPP is a more versatile protocol than SLIP, and contains functionality that SLIP does not, such
as:
· Ability to share the serial line with other protocols
· Error correction
· Support for both synchronous and asynchronous communication
· Support for different user-authentication protocols
While PPP is a more versatile serial-line protocol than SLIP, it is not available with all TCP/IP 
implementations.
You can establish a PPP or SLIP connection in one of two ways:
· By establishing a manual connection -    With a manual connection, you enter commands 

directly to the modem and the remote host via a terminal window.    
· By using the information stored in a Dialer profile - A Dialer profile contains information 

about the remote host, the local host, the modem, and various Dialer options. The Profile
dialog box lets you enter that information, and then save the profile. A Dialer profile lets 
you make a SLIP connection using the saved information simply by selecting the profile 
and clicking the Connect button on the Connect dialog box, or by choosing the profile 
from the Quick Connect list.



Preparing to Make a Connection
Making a connection, either manually or by creating a profile, requires preparation. Before 
making a connection, complete the following steps. Your network administrator can provide 
the information you need.    
1. Create a properly configured PPP or SLIP interface with the Configuration Utility. 
2. For the remote host, gather the dial-in phone number, your user name and password, 

and commands needed to start a PPP or SLIP connection. 
3. For your workstation, gather your IP address, subnet mask, COM port, modem type, 

modem baud rate, and modem specifications.    Dialer contains standard specifications 
for most modem types.    If your modem is not described on the Modem tab or on the 
Settings tab in the Configure Manual Interface dialog box, use the documentation 
supplied with your modem to find the information and enter it into your Dialer profile.    

4. Create a profile from the Connect dialog box by clicking the New... button.



Connection Status Values 
The Status column in the Dialer application window displays the status of each connection.    
Possible values are:
Active

Traffic is occurring on a connection.
Answer

A remote response was detected from the modem.
Connecting

A connection to the remote host is in progress.
Dialing

The modem is dialing.
Error

An error occurred in the modem, communications port, or kernel interface.
Idle

An active connection currently has no traffic.
Linked

A serial line session has been established with a remote host.
Negotiating

The kernel is negotiating the connection characteristics.
Offhook

The modem could not connect to the telephone line.
Shutdown

The communications and connections are shutting down.
Startup

The communications and connection parameters are initializing.
Unknown

The current status cannot be determined.
Waiting

The modem was sent information but has not yet responded.



For More Information
Recommended Reading

For an excellent conceptual overview of TCP/IP networking concepts, we recommend the 
following books:

Comer, Douglas E., Internetworking with TCP/IP, Volumes I and II, Prentice Hall
Black, Uyless D., TCP/IP and Related Protocols, McGraw

For a complete list of recommended books for users of all levels, click here.
Relevant RFCs

For more information on SLIP, consult RFC 1055, written by J. Romkey, June 1988.    
For more information on PPP, consult RFC 1661, written by W. Simpson, July 1994.
For information on PPP PAP and CHAP authentication, consult RFC 1334, written by B. Lloyd 
and W. Simpson, October 1992.
To learn how to get RFCs, click here.




